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Abstract: Lembaga Kursus Pendidikan (LKP) is an educational institution engaged in office
application training. They has good modules. But the modules dont consit the real aplication.
Exspecially, the module of the power point has not include the real world practice yet. The
method are used in this activity in the form of description of the material and practice. The
speaker made explanations about the application of Microsoft Power Point 2010, then utilizing
the results of Microsoft Power Point 2010 applications, so that they are interesting as well as
examples of their application in business applications. after that practice directly using the
application. Some important points are explained and practiced in this activity, namely the
design of interactive learning media, how to arrange the display to be interesting, and the
addition of tools integrated in power points, conversion to videos. Community service activities
at the Lembaga Kursus Pendidikan (LKP) completed on 5-6 October 2018 and attended by
twenty students, two tutors and three administrative staff. The material delivered to participants
reached 90% of all multimedian concepts and learning media. Based on the results of the
discussion and testing of the participants through questions and discussion, that £ 95% had
mastered and understood the material presented.

Keywords: Interactive Learning Media, Microsoft Power Point, Video Tutorial

Abstrak: Lembaga Kursus Pendidikan (LKP) Mandiri merupakan lembaga pendidikan yang
bergerak dalam pelatihan aplikasi perkantoran. Lembaga Kursus Pendidikan memiliki sudah
modul yang bagus. Namun dalam penerapan aplikasi perkantoran di dunia nyata belum dibahas
khususnya untuk Microsoft Power. Metode yang digunakan dalam kegiatan ini adalah deskripsi
materi dan praktek. Pemateri melakukan penjelasan-penjelasan tentang aplikasi Microsoft
Power Point 2010, pemanfaatan hasil aplikasi Microsoft Power Point 2010 sehingga menarik
serta contoh-contoh penerapannya dalam aplikasi bisnis, setelah itu praktek langsung
menggunakan aplikasi tersebut. Beberapa point penting yang dijelaskan serta dipraktekkan
dalam kegiatan ini, yaitu perancangan media pembelajaran interaktif, cara merangkai tampilan
agar menarik, dan penambahan tool terintegrasi pada power poin, konversi ke vidio. Kegiatan
pengabdian kepada masyarakat pada Lembaga Kursus Pendidikan (LKP) Mandiri Computer
Telah selesai dilaksanakan tanggal 5-6 Oktober 2018 dan dihadiri oleh peserta didik sebanyak
dua puluh orang, tutor sebanyak dua orang serta bagian administrasi sebanyak tiga orang.
Materi yang disampaikan kepada peserta mencapai 90% dari semua konsep multimedian dan
media pembelajaran. Berdasarkan hasil pembahasan dan dilakukannya pengujian terhadap
peserta dengan melalui pertanyaan-pertanyaan dan diskusi, bahwa +95% telah menguasai dan
memahami materi yang disampaikan.

Kata kunci: Media Pembelajaran Interaktif, Microsoft Power Point, Vidio Tutorial
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PENDAHULUAN
Lembaga Kursus Pendidikan
(LKP) Mandiri merupakan lembaga

pendidikan yang didirikan tahun 2011.
Lembaga ini memberikan pelatihan
mengenai dasar penggunaan aplikasi
komputer melalui pelatihan aplikasi
perkatoran seperti microsoft office.
Seperti sekolah pada umumnya lembaga
ini dilengkapi dengan fasilitas yang
memadai, satu komputer untuk per
individu setiap kali praktek. Selain itu,
lembaga ini juga telah memiliki modul
ajar yang baik dan lengkap mengenai
panduan penggunaan tiap-tiap aplikasi.

Walaupun Lembaga Kursus
Pendidikan memiliki modul yang bagus.
Namun dalam penerapan aplikasi
perkantoran di dunia nyata belum
dibahas khususnya untuk Microsoft
Power. Aplikasi ini bukan hanya
digunakan untuk presentasi saja. Namun
ada penerapan menarik lainnya yang
bisa dibuat oleh peserta kursus pada
lembaga kursus pendidikan (LKP)
Mandiri  Computer, seperti media
interaktif, vidio tutorial dan lain
sebagainya.

Berdasarkan dasar pemikiran
diatas maka kami mengajukan proposal
pengabdian masyarakat kepada
Lembaga Penelitian dan Pengabdian
pada Masyarakat (LPPM) STMIK

Royal  Kisaran  sebagai  sarana
pengembangan transfer ilmu untuk
mendapat  persetujuan  penyeleng-
garakan kegiatan Pengabdian

Masyarakat dengan judul “Pelatihan
Pembuatan Media Pembelajaran
Berbasis Power Point Pada Lembaga
Kursus Pendidikan (LKP) Mandiri
Komputer”.

Berdasarkan permasalahan yang
terjadi dan telah diuraikan pada bab
sebelumnya, maka solusi paling efektif
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adalah Membuat salah satu aplikasi
interaktif ~ dalam  bentuk  media
pembelajaran  sebagai salah  satu
implementasi dari aplikasi Microsoft
Power, Memberikan pelatihan
pembuatan vidio yang mudah melalui
integrasi ~ Microsoft  Power dan
Menyediakan modul dan tutorial
penggunaan pembuatan aplikasi media
pembelajaran interaktif melalui
Microsoft Power untuk peserta yang
mengikuti kegiatan pengabdian kepada
masyarakat.

METODE

Tahapan atau langkah-langkah
yang ditempuh agar terlaksana dengan
baik dan lancar serta tercapainya tujuan
kegiatan pengabdian kepada masyarakat
ini adalah:

1. Mempersiapkan materi yang akan
diberikan, baik  modul, slide
presentasi, dan alat peraga lainnya.

2. Memastikan tempat dan fasilitas
pendukung  seperti in  focus,
projector, dan lain-lain sudah
standby pada saat kegiatan akan
dilangsungkan.

3. Menjelaskan teori tentang materi
aplikasi  Microsoft Power Point
2010.

4. Praktek langsung pada komputer
atau laptop dalam media
pembelajaran interaktif
menggunakan aplikasi Microsoft
Power Point 2010.

5. Diskusi dan tanya jawab.

Dalam kegiatan ini pimpinan
Lembaga menyediakan tempat selama
kegiatan dilangsungkan dan fasilitas-
fasilas penunjang yang mereka miliki
untuk mendukung kegiatan ini berjalan
dengan baik dan lancar.

Setelah  kegiatan pengabdian
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kepada masyarakat ini dilakukan, maka
langkah  selanjutnya adalah  Tim
pengabdian kepada masyarakat melaku-
kan monitoring selama 3 sampai 3 kali
pada Lembaga Kursus Pendidikan
(LKP) Mandiri  Computer, untuk
memastikan para peserta didik sudah
benar-benar mampu mengim-
plementasikan aplikasi Microsoft Power
Point 2010 dalam berbagai kasus
secara maksimal atau masih belum. Jika
belum maka Tim akan membantu
mengingat-kan kembali. Tinjauan ini

dilakukan setiap satu kali dalam
seminggu pasca kegiatan.
PEMBAHASAN
Peserta Kegiatan

Kegiatan pengabdian kepada
masyarakat pada Lembaga Kursus

Pendidikan (LKP) Mandiri Computer
Telah  selesai dilaksanakan  di
Laboratorium LKP Mandiri Computer
dengan topik pelatihan pembuatan
media interaktif dalam bentuk suatu
Pembuatan Media Pembelajaran
Berbasis Power Point pada tanggal 5-6
Oktober 2018 dan dihadiri oleh peserta
didik sebanyak dua puluh orang, tutor
sebanyak dua orang serta bagian
administrasi sebanyak tiga orang.

Materi Kegiatan
a. Teoritis

Media  pembelajaran
dikatakan sebagai alat- alat grafis,
photografis, atau elektronis, yang
dapat digunakan untuk menangkap,
memproses, dan menyusun kembali
informasi visual atau verbal atau
merupakan komponen sumber belajar
atau wahana fisik yang mengandung
materi instruksional di lingkungan
siswa yang dapat merangsang siswa

dapat
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untuk belajar (Syah et al. 2018).

Media pembelajaran  berkem-
bang dari waktu ke waktu, seiring
dengan  perkembangan  teknologi.
Bebe-rapa ahli menggolongkan
macam- macam media pembelajaran
dari sudut pandang yang berbeda.

Media  pembelajaran  dalam
bukunya meliputi: nonprojected media,
projec-ted media, audiomedia,
motionmedia, computer  mediated

instruction, computer based multimedia
and hypermedia, media radio and
television. Nonprojected media berupa
photographs, diagrams, displays, dan
models. Projectedmedia terdiri dari
slides, filmstrips, overhead transparen-
cies, dan computer  projection.
Audiomedia berupa cassettes dan
compact discs, sedangkan motionmedia
berupa video dan film. (Naz 2008)

Arsyad(2011) mengelompokkan
media pembelajaran menjadi empat
kelompok, yaitu media hasil teknologi
cetak, media hasil teknologi audio
visual, media hasil teknologi komputer,
dan media hasil gabungan teknologi
cetak dan komputer.

Berdasarkan macam-macam
media tersebut di atas, menunjukkan
bahwa media pembelajaran senantiasa
mengalami  perkembangan  seiring
kemajuan  ilmu dan  teknologi.
Perkembangan media pembelajaran
juga  mengikuti tuntutan dan
kebutuhan  pembelajaran, sesuai
dengan situasi dan kondisi yang ada
(Sutirman,2013).

Levie & Lents dalam Azhar
Arsyad (2007) mengemukakan empat
fungsi media pembelajaran, khususnya
media visual, vyaitu fungsi atensi,
fungsi afektif, fungsi kognitif, dan
fungsi kompenstoris.

Media pembelajaran
adalah media pembelajaran

interaktif
yang
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berbasis  komputer.  media  ini
menggabungkan dan mensinergikan
semua media yang terdiri dari teks,
grafis, foto, video, animasi, musik,
narasi, dan interaktivitas yang
diprogram berdasarkan teori
pembelajaran (Nandi dalam (Hamadin
2015)Hamadin, dkk., 2006: 7).

Minat siswa untuk mengikuti
pembelajaran yang berlangsung.
Petunjuk-petunjuk dan tombol interaktif
yang tersedia di dalam media
pembalajaran interaktif mudah untuk
digunakan serta kontenkonten yang
terdapat didalam media tersebut sangat
bermanfaat dalam menambah
pengetahuan siswa (Hamadin 2015).
Model media pembelajaran interaktif,
diantaranya adalah model praktik dan
latihan (drill and practice), tutorial,

permainan (games), simulasi
(simulation), penemuan (discovery),
dan pemecahan masalah (problem

solving) (Daryanto, 2011: 132)

Pembuatan Media
Menggunakan

b. Tahapan
Pembelajaran
Microsoft Powe Point

1. Mendesain Template

Tahapan pembuatan template
dijabarkan sebagai berikut: 1) Buka

program Ms PowerPoint  2007; 2)

desainlah background untuk tampilan

slade anda, anda boleh menggunakan

shape, chart, smartArt, yang berada di

menu insert; 3) jika anda menggunakan

gambar sebagai background carilah
gambar yang sesuai dengan tema yang
anda singgung dalam tutorial anda. Atau
secara default anda bisa menggunakan
background yang sesuai dengan
template power point. Power point
menyediakan template-template yang
cukup  menarik.; 4)  Kemudian
tambahkan icon interaktif pada slade
berupa panel-panel. Icon interaktif bisa
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dipilih dari shape pada menu insert.
Untuk menampil kesan interaktifnya
anda dapat memberikan pengaturan
emboss dengan memberikan pengaturan
pada menu format, shapes effect,
bevels; 5) Tambahkan icon home, next (
- ), Back ( € ) dan close atau exit ( X
) seperti pada gambar contoh template.
2. Mengatur Master Slide

Cara termudah untuk membuat
perubahan yang sama untuk semua slide
atau slide yang menggunakan tata letak
tertentu adalah mengubah slide master,
juga disebut master slide. Sebagai
contoh, bayangkan bahwa Anda seperti
sebuah tema, tapi ingin mengubah
elemen desain tertentu dari tema. Anda
mungkin ingin gaya bullet yang
berbeda, judul slide yang pusat margin
bukannya kiri, atau aksen garis di
bawah judul masing-masing slide. Anda
dapat dengan cepat membuat perubahan
ini dan lebih dengan memodifikasi slide
master.

Tahap mengubah master slide
adalah dengan memilih tab [View] lalu
Klik perintah [Slide Master] di grup
[Presentation Views] dan Tab Master
slide akan muncul sebagai tab aktif di
Ribbon, dan task pane master slide
akan muncul di sebelah kiri.

Tampilan slide master muncul
mirip  dengan  tampilan  normal,
namun pada tampilan slide master
objek akan ditampilkan dalam panel
dari slide yang sebenarnya. Gambar
kecil pertama di task pane di sebelah
kiri ~adalah slide master yang
mengontrol semua slide. Jika Anda
ingin membuat perubahan ke semua
slide dalam presentasi, Anda dapat
melakukannya dengan mengubah slide
ini.

Setiap slide di bawah slide
master adalah master slide untuk
mendukung tata letak. Misalnya, jika
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Anda ingin membuat perubahan ke

semua slide dengan menggunakan judul

dan isi tata letak, Anda dapat

melakukannya dengan menggunakan

tata letak Judul dan Isi master slide

pada taskpane.

3. Memberikan Action Pada Menu

1) Masuk ke Slide Master, Klik View
> Slide Master

2) Klik menu yang diinginkan Klik
Insert > Action

3) Pilih Hyperlink to > Slide xxx
(xxx pilihlah sesuai dengan urutan
slide diatas, yaitu slide 2) > OK

[Jelay sound:

Gambar 1 Hyperlink to Slide

4) Ulangi untuk
berikutnya

5) Pada menu Home >klik kanan >
Klik Action settings hyperlink to >
First Slide

6) Pada menu Exit > klik kanan >
Klik Action settings > End Show

7) Pada menu Next dan previous>
klik kanan > Klik Action settings >
Pilih Previous slide atau next slide

8) Kalau sudah Kkeluar dari slide
master kembali ke Normal
caranya: Klik
View > Normal

9) Cobalah dengan tekan F5 atau Slide
Show>From Beginning

10) Klik Office Button > Save As dan
beri nama file pada kotak file name.

4. Mempublish File dengan iSpring
Presenter

File yang telah dibuat tersebut jika

menu-menu
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dijalankan (Slide Show), menu quiz
belum dapat Dberjalan. Hal ini
disebabkan quiz tersebut masih berupa
file iSping Presenter. Supaya quiz
tersebut dapat dijalankan maka file
pptx tersebut harusdipublih terlebih
dahulu dengan iSpring Presenter.
Langkahnya adalah Klik menu iSpring
Presenter > Publish. Pada Jendela
Publish to Flash, klik web > General >
Presentation Tittle. Lalu Beri nama
Presentation Title misal
MediaPembelajaran Interaktif.
Kemudian Pada bagian Destination, klik
My Computer dan tetukan lokasi folder
untuk menyimpan file pada kotak Local
Folder, dan beri nama file nya pada
kotak File Name (misal Media
Pembelajaran Interaktif). Dan Pada
bagian Slide Range pilih All Slide. Pada
bagian Flash Output, klik Presentation >
All in one Flash file (untuk mengubah
file .pptx menjadi file .swf). Terakhir
Klik Generate EXE ( untuk mengubah

file .pptx menjadi file
executable(.EXE)).
Jika Flash  Output  hanya

memilih All in one Flash File, maka
file yang didapatkan adalah file flash
movie atau file .swf saja, jika flash
output yang dipilih All in one Flash file
dan Generate EXE maka file yang
didapatkan hanya file executable (file
.exe)

A. Dokumentasi Kegiatan

P JMASYARAKAT
5ie 'rOYAL KISARAN
ANTEMA
AN MEDIA PEMBELAJARAN
POINT 2010 PADA
DIDIKAN ( LKP ) MANDIR!

Gambar 2. Tim Pengabidan
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Gambar 3 Training dan pemberian
Materi

SIMPULAN

Berdasarkan kegiatan pengab-
dian kepada masyarakat yang dilakukan
pada Lembaga Kursus Pendidikan
(LKP)  Mandiri  Computer  dapat
disimpulkan bahwa:

1. Kegiatan  pengabdian  kepada
masyarakat yang dilakukan oleh
Tim  kegiatan  (dosen  dan
mahasiswa STMIK Royal Kisaran)
tepat pada sasaran. Materi kegiatan
yang diberikan kepada peserta
dapat digunakan dan dimanfaatkan
untuk memperluas  wawasan
penggunaan aplikasi perkantoran
yang dasarnya sudah mereka
kuasai.

2. Materi yang disampaikan kepada
peserta mencapai 90% dari semua
konsep multimedian dan media
pembelajaran. Penyampaian materi
terdiri dari beberapa sesi, yaitu:
penjelasan, praktek , dan diskusi.

3. LKP Mandiri Computer telah
memiliki  fasilitas  laboratorium
komputer yang  baik.  Tim

pengabdian sangat terbantu dengan
peminjaman fasilitas tersebut. Tim
pengabdian hanya menyediakan
satu buah infokus untuk
menampilkan slade presentasi.
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